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What is New in this Release
This release of Eudora Light for Windows includes the following new features:

l A native, fully compatible 32-bit version for the Windows 95 and Windows NT operating systems.

l Context-sensitive on-line Help that lets you click on items in the user interface to read brief explanations of what 
the items do. 

l Active URLs that automatically open your World Wide Web browser and go to the selected URL 
(Uniform Resource Locator). 

l New Dialup options for dialup connections. 

l A Miscellaneous option for switching messages using the Ctrl+arrow keys.

l A floating toolbar you can place anywhere on your desktop (only in the 32-bit version).

l A New Mail    icon for the Task Bar Tray that displays the number of new messages
(only in the 32-bit version under Windows 95).



What has Changed in this Release
This release of Eudora Light for Windows includes the following changes from version 1.5.2:

l The Eudora functions that were in the Window menu are now in a new Tools menu.

l The Settings dialog is now called Options and is in the new Tools menu.

l In the Nicknames window, you can use the right mouse button to toggle nicknames on and off of the Quick 
Recipient List. You can no longer do this using the left mouse button.



 Win32s Compatibility
If you are running Win32s, we suggest using the 16-bit version of Eudora Light for Windows. If you must run the 32-
bit version of Eudora under Win32s, be sure    to run Win32s version 1.3 or later.



Using Active URLs
Any string of text that Eudora recognizes as a URL (Uniform Resource Locator: http, ftp, gopher, ph, finger,    etc.) is 
active. When you hold the mouse over the URL the arrow changes to a pointing hand, and you can double-click on it 
to open the URL. Depending on what the URL is, you can go to a World Wide Web location, transfer a file, do a 
gopher search, use the finger tool, etc. 

For most URLs your Web browser is opened and acts on the URL. For ph, finger, and mailto URLs, Eudora acts on 
the URL and displays the Ph window or a new outgoing message.



Headquartered in San Diego, QUALCOMM develops, manufactures, markets, licenses and operates advanced 
communications systems and products based on its proprietary digital wireless technologies. The Company's primary
product areas are the OmniTRACS® system (a geostationary satellite-based, mobile communications system 
providing two-way data and position reporting services), CDMA wireless communications systems and products and, 
in conjunction with others, the development of the Globalstar low-earth-orbit (LEO) satellite communications system.   
Other Company products include the Eudora Pro electronic mail software, VLSI components and communications 
equipment.

For more information on QUALCOMM and its wireless communications products, send e-mail to 
info@qualcomm.com or browse the QUALCOMM Worldwide Web Home Page <http://www.qualcomm.com>.

For more information on Eudora by QUALCOMM, send e-mail to eudora-info@qualcomm.com or browse the QUEST 
Worldwide Web Home Page <http://www.qualcomm.com/quest>.



Reporting Bugs
If you experience something you think might be a bug in Eudora, please report it by sending a message to <eudora-
bugs@qualcomm.com>. Describe what you did, what happened, what version of Eudora you have, any error 
messages Eudora gave (the numbers in ()'s are especially important), what kind of computer you have, which 
operating system you're using, and anything else you think might be relevant.

You will receive an automated response indicating that your bug report has been received and forwarded to our 
engineering staff. Unless additional information is needed, you will not receive a direct response.



Suggestions
From time to time, everyone comes up with an idea for something they'd like their software to do differently. This is 
true of all applications, no less Eudora. If you come across an idea that you think might make a nice enhancement to 
Eudora, your input is always welcome. Please send any suggestions or requests for new features to <eudora-
suggest@qualcomm.com>.

You will receive an automated response indicating that your suggestion has been received and forwarded to our 
engineering staff. Unless additional information is needed, you will not receive a direct response.



[Shift] + Key Equivalents
The [Shift] key is usually used to make an operation more sophisticated or to reverse option settings.

[Shift] + Queue or Send displays the Change Queuing dialog.

[Shift] + Reply toggles the Reply to all option in the Settings dialog (Replying). If Reply to all is turned 
on, [Shift] + Reply generates a reply to the sender only. If Reply to all is turned off, [Shift] + 
Reply generates a reply to all addresses in the message header.

[Shift] + Transfer sends a copy of the current message to the selected mailbox and retains the original 
message in the original mailbox.

[Shift] + Copy text removes the carriage returns from "wrapped" text prior to copying it to the clipboard.

[Shift] + Wrap Selection unwraps the selected text instead of wrapping it.

[Shift] + Insert a nickname inserts the full nickname expansion in the specified field.

[Shift] + Finish Nickname inserts the full nickname expansion in the specified field.

[Shift] + Save saves changes to any open windows.

[Shift] + Close closes all open windows.

[Shift] + Quit instructs Eudora that all open windows are to automatically reopen at the next startup.



[Ctrl] + Key Equivalents
[Ctrl] + [A] Select all

[Ctrl] + [B] Move window behind another window

[Ctrl] + [C] Copy 

[Ctrl] + [D] Delete message

[Ctrl] + [E] Queue an outgoing message

[Ctrl] + [F] Open Find window (search for message)

[Ctrl] + [G] Find again

[Ctrl] + [H] Attach a file to an outgoing message

[Ctrl] + [I] Open In mailbox

[Ctrl] + [J] Filter messages

[Ctrl] + [K] Make nickname

[Ctrl] + [L] Open Nicknames window

[Ctrl] + [M] Check mail

[Ctrl] + [N] New message

[Ctrl] + [O] Open message 

[Ctrl] + [P] Print message

[Ctrl] + [Q] Quit Eudora

[Ctrl] + [R] Reply to message

[Ctrl] + [S] Save contents of top window

[Ctrl] + [T] Send queued messages

[Ctrl] + [U] Open Ph window

[Ctrl] + [V] Paste

[Ctrl] + [W] Close message

[Ctrl] + [X] Cut

[Ctrl] + [Z] Undo

[Ctrl] + ['] Paste as quotation

[Ctrl] + [,] Finish nickname

[Ctrl] + [=] Enter selection

[Ctrl] + [;] Next (Find)



Other Important Keys
The arrow keys, depending on the settings in the Settings dialog (Miscellaneous), can move you from one message 
to another in a mailbox. If the Unmodified arrow keys or Alt-arrow keys option in the Settings dialog is turned on:

l Up Arrow/Left Arrow or [Alt] + Up Arrow/Left Arrow takes you to the previous message.

l Down Arrow/Right Arrow or [Alt] + Down Arrow/Right Arrow takes you to the next message.

The [Enter] key performs several different functions, as follows:

l It selects the outlined button in any dialog, alert, or window.

l It opens the selected message(s).

l It opens the selected attachment in a message window.

l It lets you begin or end editing the subject of a message.

The [Esc] key stops any operation currently in progress.

The [F1] key displays the On-line Help menu.

The following keys are also useful:

l [Del] deletes the character to the right of the insertion point.

l [Home] scrolls to the beginning of a line.

l [End] scrolls to the end of a line.

l [Page Up], [Page Down] scrolls up or down through the window.



Creating & Saving a Message
1. From the Message menu, select New Message.

2. Type an E-mail address (or nickname you created) in the To: field.

If you are sending the message to more than one person, separate their addresses with commas.

3. Press [tab] to move the blinking cursor to the Subject: field.

4. Type in the subject of your message (optional but useful).

5. Press [tab] and type in the Cc: field E-mail address (optional).

6. Press [tab] and type in the Bcc: field E-mail address (optional).

7. Press [tab] and type in the body of the message. 

8. To save the message, select Save from the File menu. Your message is saved in the Out mailbox and marked 
with a bullet (l). You can continue writing the message, or come back to it later.



Sending a Message
There are two ways to send mail with Eudora: You can send a message immediately, or put it in a queue to be sent 
later. To specify the option you want and then send your mail, do the following:

1. Select Settings... from the Special menu and click on the Sending Mail category. Check the Immediate send 
box if you want to send your mail immediately, or uncheck it if you want to put mail in the queue.

2. In the message window, click Send/Queue.



Attaching a File to a Message
Any file can be attached to and sent with a Eudora message.    To attach a file to a current outgoing message, do the 
following:

1. From the Message menu select Attach Document... 
A standard file dialog is displayed. 

2. Locate and select the file you want to attach, then click on the OK button. 

The file is listed in the Attachments: field of the message. You can add as many files as you want using the same
process. 

To delete an attachment, click on it to select it, then press the [delete] key.

To set various options for how you receive attachments, select Settings... from the Special menu and click on the 
Attachments category. 



Creating a Signature
A signature is a brief message that is automatically added to the end of outgoing messages. It can include your 
name, address, telephone number, or whatever you want it to.

To create a signature, do the following:

1. Select Signature from the Tools menu.
The Signature window is displayed so that you can create or edit your signature.

2. Close the Signature window. An alert is displayed asking if you want to save your changes. Click Yes.

To include your signature in your messages, use the signature combo box on the message window, or the Use 
Signature option in the Sending Mail Options category.



Checking For Mail Manually
To check for incoming mail, do the following:

1. From the File menu select Check Mail. 

2. If Eudora asks for your password, type it in the Password dialog and click OK (Eudora passwords are "case-
sensitive").

3. If there is no new mail, a "no mail" alert is displayed; click OK.
(If you have the Alert setting turned off in the Getting Attention category, there is no dialog.)

4. If you have new mail, Eudora transfers the messages one by one and then displays a "New Mail" alert; click OK.

5. New messages are delivered to your In mailbox. This mailbox opens automatically and your new message 
summaries are added to the end of the mailbox list. Double-click a message summary to open it.



Checking For Mail Automatically
To set up automatic mail checking, do the following:

1. From the Tools menu, select Options.... The Options dialog is    displayed.

2. Select the Checking Mail category.

3. In the Check For Mail Every ? Minute(s) field, type the number of minutes between automatic mail checks (15 is 
the recommended minimum interval).

4. Click OK to close the Options dialog.

5. Eudora automatically checks for mail at the interval you have requested.

Note: When automatic mail checking is on, the time of the next mail check is listed next to the Check Mail 
command under the File menu.



Setting Up a Filter
Eudoras message filtering lets you automatically organize and modify incoming messages based on the attributes of 
the message. To create a filter, do the following:

1. Select Filters from the Tools menu. The Filters window is displayed.

2. Click on the New button. (Eudora will name the filter based on the criteria.)

3. Check Incoming or Outgoing to specify what messages the filter should act on, and check Manual if you dont 
want the messages filtered automatically. (Select Filter Messages from the Special menu to filter Manual 
messages.) 

4. Specify the filter terms: What part of the message to look at, what text to look for, and how that text behaves in 
the specified message part.

5. Specify a second set of filter terms if you need to.

6. Specify the action to be taken on filtered messages: A subject, label, or priority change, or a mailbox transfer.

7. Select Save from the File menu, or close the Filters window and click OK in the alert that is displayed.



Replying to a Message
You reply to a message when you want to respond to its sender.

1. Select or open the message you want to reply to.

2. From the Message menu, select Reply to display a new composition window. Eudora completes the To:, From:, 
and Subject: fields based on the original message. 

Eudora also copies the text of the original message into the reply. Each line from the original message is 
preceded by a ">" marker. The ">" markers offset the original text, so readers can distinguish your text from the 
text you're replying to.

3. Remove those parts of the original text that you don't want to include in your reply and type in your own text.

4. Once your response is completed, click Send (or Queue).

Tip: If you want to address the reply to everyone who received the original message (and not just the 
sender), hold down the [Shift] key when you select Reply from the Message menu.



Forwarding a Message
You forward a message when you want someone else to see it.

1. Select or open the message you want to forward.

2. From the Message menu, select Forward to display a new composition window. Eudora completes the Subject: 
field based on the original message and transfers the header and body of the original message to the new 
message body. Each line is preceded by a ">" marker. 

3. Type the addresses of the people you want to forward the message to in the To: field.

4. The existing text may be edited, and more text may be added to the message.

5. Once the editing is completed, click Send (or Queue).



Redirecting a Message
Eudora's Redirect command lets you send a message that was sent to you to someone else, while allowing the 
recipient of the redirected message to reply directly to the original sender.

1. Select or open the message you want to redirect.

2. From the Message menu, select Redirect to display a new composition window. Eudora completes the From: 
field with the address of the originator and the words "by way of" followed by your address. The Subject: field and
message body are also completed based on the original message. 

3. Type the addresses of the people to whom you wish to redirect the message in the To: field.

4. The existing text may be edited, and more text may be added to the message.

5. Once the editing is completed, click Send (or Queue).

Note: E-mail courtesy suggests that you not do much editing of the message you're redirecting. If you must 
add comments, put them in []s with your initials, like: [Don: please reply to this right away. SD]



Transferring a Message
1. Select or open the message you want to transfer.

2. Select the name of the mailbox you want to transfer it to from the Transfer menu (if you hold down the [Shift] 
key while transferring a message, a copy of the message is transferred and the original message remains in the 
original mailbox).

Tip: You can create a new mailbox and transfer a message into it all in one step. Instead of selecting an 
existing mailbox, select New... from the Transfer menu.

Tip: If you transfer a message and decide you put it in the wrong mailbox, select Undo Transfer from the 
Edit menu.



Deleting a Message
There are four ways to delete a message or messages, as follows:

1. Select or open the message you want to delete. Select Delete from the Message menu.

2. In an open mailbox window, select the message(s) you want to delete. Press the [Delete] key. 

3. In an open mailbox window, select the message(s) you want to delete. Click the trash can icon on the main 
window toolbar. 

4. Select or open the message you want to delete. Select Trash from the Transfer menu.

Note: All deleted messages are put into the Trash mailbox. You can set an option to automatically empty the 
Trash mailbox when you quit Eudora.



Changing Your Password
1. Select Change Password from the Special menu to display the Password dialog.

Note: The Change Password command will only work if you have the necessary software on your server.

2. Type in your current password and click OK.

3. Eudora asks you to type in your new password and click OK.

4. To verify the change, type in your new password again and click OK.

5. If your new password is rejected, repeat steps 1 through 4.



Creating, Renaming, and Removing Nicknames
Nicknames are personal aliases for full e-mail addresses. A single nickname can be used to represent a mailing list.

1. Select Nicknames from the Tools menu. The Nicknames window is displayed.

2. To create a new nickname, click the New button. To rename a nickname, select the nickname then click the 
Rename button.

3. Type the nickname title in the Nickname dialog, put it on the recipient list if you want, and click OK.

4. Type the full e-mail address(es) in the Address(es) field.

5. If you have any comments related to the nickname, type these in the Notes field.

6. To remove a nickname, select it, then click the Remove button. 

7. Select Save from the File menu to save the nicknames file, or close the Nicknames window and save the 
changes.

Note: You can use a nickname in a mailing list. However, that nickname must be created individually in the 
Nicknames window.



Accessing a Nicknames File on a Server
Eudora can now be configured to access a nicknames file (or files) on a network server. A new entry may been added
to the EUDORA.INI file called ExtraNicknameDirs. Add this entry to the[Settings] section of the EUDORA.INI file, 
followed by the directory that contains the nicknames file (or files), and it will locate this directory and add the 
nicknames file(s) to the Nicknames window. To add nicknames files from different directories, list the directories after 
the ExtraNicknameDirs command and separate them by a semicolon (;).



EUDORA.INI Settings File
The EUDORA.INI file is where Eudora keeps most of the settings.    It is a standard Windows INI file, and may be 
edited with any text editor.    

Note: Since Windows caches information from INI files in memory while the program is running, you should 
never change the EUDORA.INI file while Eudora is in use.    If you need to make a change, first quit 
Eudora, then edit the file, and then restart Eudora.

The EUDORA.INI file is broken up into 5 sections:

[Settings]
[Dialup]
[Window Position]
[Debug]
[Mappings]

Only the items that are not configurable from the Settings dialog are listed here.

Name and Location of the INI File
The default name is EUDORA.INI and the default location is in the mail directory.    But the name and location can be 
changed.

To specify a different INI file from the EUDORA.INI that is not in the mail directory, add a second parameter to the 
command line in the Program Item for Eudora, e.g.
Command Line: c:\apps\eudora.exe c:\mymail c:\inis\myeudora.ini

To use a different INI file that is in the mail directory:
Command Line: c:\apps\eudora.exe c:\mymail myeudora.ini
Command Line: c:\apps\eudora.exe c:\mymail\myeudora.ini

This is a way to have multiple settings for one set of mailboxes, nicknames, etc.    For example, you may have 
multiple e-mail accounts in which you receive mail, but want to collect mail from all of the accounts in one place.    You
could set up separate Program Items for each account (each having a different INI file on the command line), and 
switching between accounts would be as simple as double-clicking on a Program Item.

And for an even more tricky specification, if the first parameter is an INI filename without a path, then the mail 
directory is searched through the normal process of checking the EUDORA environment variable and then using the 
executable directory.

Examples:
SET EUDORA=c:\mymail
Command Line: c:\apps\eudora.exe myeudora.ini

will use c:\mymail as the mail directory and c:\mymail\myeudora.ini as the INI file.
SET EUDORA=myeudora.ini
Command Line: c:\apps\eudora.exe

will use c:\apps as the mail directory and c:\apps\myeudora.ini as the INI file.

Default INI file
When an entry in the EUDORA.INI file is not found, Eudora will look in the DEUDORA.INI file located in the same 
directory as the EUDORA.EXE file. The [Mappings] section of the DEUDORA.INI file acts as though it was appended 



to the end of the [Mappings] section of the EUDORA.INI file.



[Dialup]
The [Dialup] section controls the use of the dialup connection method.    See "Appendix E - Dialup Eudora" in the 
manual for more detailed information.

Entry Default Value Description
ATSendDelay 100 The delay between sending characters 

in a modem AT command and in the 
EchoCancelString (in milliseconds).

BreakTime 150 Length of modem break command (in 
milliseconds).

BusyRetries 0 The number of times that the phone will
be redialed after receiving a busy signal.

BusyRetryDelay 5 The number of seconds between redials 
after receiving a busy signal.

EndScript SERIAL.END Script used when closing modem 
connection.

SMTPHELOString String to send as the parameter of the 
SMTP HELO command.

TelnetCommand telnet {System} {Port}\r\
n

Telnet command issued to use the 
network services (i.e. POP, SMTP, ph, 
finger, and Eudora password changer).

[Debug]
The [Debug] section controls aspects of the Eudora log file.    The Eudora log file is a handy tool for debugging 
network connections, especially when using the dialup connection method.

Entry Default Value Description
LogFileName EUDORA.LOG The name of the log file.
LogFileSize 100 The size of the log file (in KB) when it will be copied to the file 

EUDORLOG.OLD and a new log file will be started.
LogLevel 0 A bit-mapped value telling what type of information to log:

Bit 1    (1): Sending of a message
Bit 2    (2): Receipt of a message
Bit 3    (4): Dialup script navigation commands
Bit 4    (8): Alert messages
Bit 5 (16): Progress messages
Bit 6 (32): All bytes sent
Bit 7 (64): All bytes received

[Mappings]
This is a sample [Mappings] section.    It is NOT a default for Eudora if you have a missing/empty [Mappings] section.  
The [Mappings] section contains information for mapping between PC file extensions, Mac creator and type, and 
MIME type and subtype for attachment files (in that order).    Entries marked as "in" work only on incoming messages 
and entries marked as "out" work only on outgoing messages.    Entries marked "both" work on both incoming and 
outgoing messages.

For a more detailed explanation, see "Appendix D - MIME and Mappings" of the Eudora manual.
out=txt,ttxt,TEXT,text,plain
both=doc,MSWD,,application,msword
in=xls,XCEL,,,
out=xls,XCEL,XLS4,,
both=xlc,XCEL,XLC3,,
both=xlm,XCEL,XLM3,,
both=ppt,PPT3,SLD3,,
both=wp,WPC2,.WP5,application,wordperfect5.1



both=zip,,,application,zip
both=rtf,,,application,rtf
both=ps,,,application,postcript
in=eps,,EPSF,,
out=eps,dPro,EPSF,application,postscript
both=mpg,,,video,mpeg
both=jpg,,,image,jpeg
both=gif,,,image,gif
both=tif,,,image,tiff
both=pct,,PICT,,
both=mac,MPNT,PNTG,,



[Window Positions]
The [Window Position] section saves the positions of the standard windows (not your mailboxes and messages).

Entry Default Value Description
CheckSpellingWindowPosition 0,0,0,0
DebugTraceWindowPosition 110,185,635,500
FilterReportWindowPosition 10,10,500,300
FiltersWindowPosition 60,345,580,480
FindWindowPosition 60,345,580,480
InputDialogWindowPosition 50,100,358,450
MailboxesWindowPosition 80,80,565,415
MainWindowPosition 0,0,640,480
NicknamesWindowPosition 50,5,590,475
PhWindowPosition 10,40,630,440
ProgressWindowPosition 0,0,0,0
Signature2WindowPosition 10,60,630,240
SignatureWindowPosition 10,60,630,240
TextFileWindowPosition 0,0,600,460

[Settings]

Entry
Default 
Value Description

BadPasswordString When the POP server returns an error on 
sending the PASS command, the password 
will only be erased when the error response 
includes this text.

CenterUnreadStatus 1 When on (1), centers the bitmap in Mailbox 
menu items that indicates that the mailbox 
has unread messages.    If the display of this 
bitmap is not correct, turn this switch off (0).

CompactDisk% 5 What the amount of "wasted space" taken 
up by deleted messages in a mailbox as a 
percentage of total free disk space must be 
before the mailbox automatically gets 
compacted when closed.

CompactMailbox% 50 What the percentage of "wasted space" 
taken up by deleted messages in a mailbox 
must be before the mailbox automatically 
gets compacted when closed.

EudoraPassPort 106 Default port number for the Eudora 
password changing service (epass).

ExtraHeaders Extra headers that are sent with each 
outgoing message.
If multiple headers are to be sent, separate
each with "\r\n".    
For example, 
"ExtraHeaders=X-Header1: foo\r\nX-
Header2: bar".

ExtraNicknameDirs List of directories to search for additional 
nickname files.    Multiple directories can be 
entered, separated by semicolons (;).

FindMatchCase 0 "Match Case" checkbox in the Find dialog.
FindSummariesOnly 0 "Summaries Only" checkbox in the Find 

dialog.
FingerDefault 0 Tells whether or not the Ph window should 

default to finger.
FingerPort 79 Default port number for the finger service 

(finger).
FlushDiskCache 0 If on(1), Eudora will flush the disk write 



cache before sending the command that 
deletes a message from the POP server.    
This is only necessary if you are using disk 
caching software (e.g. SmartDrive), have 
write caching turned on, and are sensitive 
about the unlikely chance that your machine
may hang right after deleting a message 
from the POP server but before the write 
cache gets flushed.

GuessParagraphs 0 "Guess Paragraphs" checkbox in the Save 
As... dialog.

IdleTime 60 The number of seconds that Eudora has to 
be idle before it will consider performing an 
automatic mail check.

IncludeHeaders 0 "Include Headers" checkbox in the Save As...
dialog.

KerberosSetUserName 0 Uses KClient SetUserName() function to set 
user name in Kerberos system.    Turning this
switch on may cause Kerberos tickets to be 
invalidated.

LastSettingsCategory 0 Last category that was displayed in the 
Settings dialog.

LexPath Directory in which the dictionary files for 
spell checking reside.

MainLexFiles Main dictionary files.    British dictionaries 
can be used by changing this to sscebrc.tlx, 
sscebrm.clx, ssceamc. tlx, ssceamm.clx 

MainWindowState 1 The state of the Main Window (normal = 1, 
minimized = 2, or maximized = 3 ).    The 
state is set when Eudora closes, and the 
Main Window is set to this state the next 
time Eudora starts up.

NicknameAddressesHeight 60 Percent of height of Nicknames window that 
the Address(es) field takes up.

NicknameListWidth% 33 Percent of width of Nicknames window that 
the list of nicknames takes up.

NoSplashScreen 0 If on, the openning splash screen (aka About
Box) will not be displayed

NumberofTraceLines 300 The number of lines saved in the Trace 
window.

PhPort 105 Default port number for the Ph service 
(csnet-ns).

PhReturn A string that is appended to every Ph 
command before sending to the Ph server.    
For example, "PhReturn=return all" would 
return all fields of the records returned by 
the query, and "PhReturn=type=person" 
would return all matches to the query with 
the additional filter that the record is a 
person.

POPPort 110 Default port number for the POP service 
(pop3).

PrintHeaders 1 When on (1), printed messages get headers 
and footers.

QuoteEnd The string that gets inserted after the the 
original text of a forwarded message.    A 
newline is added before the string.

QuotePrefix > The string that precedes all lines of the 
original message in a forwarded message

QuoteStart The string that gets inserted before the the 
original text of a forwarded message.    A 
newline is added after the string.

ReplyAllAttribution At %1, %2 Attribution line when a Reply to All is done.



wrote:
ReplyAttribution At %1, you 

wrote:
Attribution line when a Reply is done.

ReplyEnd The string that gets inserted after the the 
original text of a replied message.    A 
newline is added before the string.

ReplyPrefix > The string that precedes all lines of the 
original message in a replied message

ReplyStart The string that gets inserted before the the 
original text of a replied message.    A 
newline is added after the string.

ReturnAddressFormat %1 < %2> Format of the From: field in outgoing 
messages.    %1 is the Real name, and %2 is 
the Return address.

SaveDialupPasswordText Where your dialup password is saved (in an 
encrypted format) if you have the Save 
Password switch turned on.

SavePasswordText Where your POP password is saved (in an 
encrypted format) if you have the Save 
Password switch turned on.

ShowProgress 1 Show/hide the Progress window
SMTPPort 25 Default port number for the SMTP service 

(smtp).
SMTPRecipientWrap 72 Column at which recipent headers (To: and 

Cc:) are wrapped when sending a message.
TabooHeaders Received,

Status,
Message-Id,
In-Reply-To,
X-Priority,
Mime-
Version,
Content-
Type,
Content-
Transfer-
Encoding,
X-Mailer,
X-UIDL,
X-400,
Precendenc
e

A comma separated list of headers (without 
colons) that shouldn't be shown when the 
Show all headers switch ("Blah Blah Blah" 
icon) is off for a message.    The matching is 
done on a prefix basis, so any header that 
begins with one of these values will not be 
shown.

TabStop 8 How many spaces to insert for a <Tab> in 
the body of a composition message.

TimeZone This should contain the time zone in which 
you are located, in the following format:

TimeZone=xxxnnnyyy
where xxx, yyy are timezone abbreviations 
like PST, PDT, CDT, and nnn is the offset in 
hours WEST of GMT (i.e those that are east 
of GMT should enter a negative number 
here).    xxx is the timezone during Standard 
Time and yyy is the timezone during 
Daylight Savings Time.    If you do not 
change your clocks during Daylight Savings 
Time, leave yyy blank.    Here's some 
samples:

TimeZone=PST8PDT
TimeZone=MET-1

If you don't specify a TimeZone entry, then a
Date: header will not be put in outgoing 
messages, which is fine for most because 



their mail server will insert the correct Date: 
header.    The moral is: if you don't get 
messages bounced because of a missing 
Date: header, then leave the TimeZone 
entry alone.

TraceWindowMask 31 Log level of information that gets sent to the
Trace window (see the [Debug] section).

TocDateLeeway 2 Number of seconds that the date on a 
mailbox .TOC file can be behind the .MBX 
file that Eudora will not flag as being out of 
date. Helpful for network file systems.

UnreadExpires 5 The number of days after which a message 
is no longer used to determine if a mailbox 
has unread messages in it.

URLHelper Full path of application used to launch URLs.
UsePOPSend 0 If UsePOPSend is on, Eudora will send mail 

using the POP3 extended command XTND 
XMIT.    Since this is an optional command for
POP3, many POP3 servers do not support 
this command (Berkeley's popper, however, 
does).    There are pros and cons to using 
POP3 to send your mail.    It provides a level 
of security since it requires a 
username/password pair to send mail 
messages, unlike SMTP.    It is faster than 
SMTP, especially when checking for new 
mail at the same time.    It doesn't check for 
valid recipients until the entire message is 
sent, and some implementations (Berkeley's
popper, for example) won't tell you which 
recipients are invalid and will send the 
message to the valid recipients anyway.

UserChangeLex uchange.tlx Filename of user-defined list of words to 
change when spell checking.

UserIgnoreLex uignore.tlx Filename of user-defined list of words to 
ignore when spell checking.

UserSuggestLex usuggest.tlx Filename of user-defined list of words to 
suggest when spell checking.

WordWrapColumn 76 Column in which lines are wrapped at in 
outgoing messages when the Word wrap 
switch is on.

WordWrapMax 80 Length at which a line is considered too 
long, and must be wrapped in outgoing 
messages when the Word wrap switch is on.



Priority Combo Box

Specifies the priority of the message as it is displayed in the mailbox window.



BLAH ,BLAH, BLAH Icon

Displays all message headers. This can be useful when tracking down a network problem.



Trash Icon

Specifies that the next time Eudora checks the server for mail it should also delete this message from the server. 

This icon works in conjunction with the Leave mail on server option in the Options dialog (Checking Mail).



Fetch Icon

This icon works in conjunction with the Skip messages over ? K in size option in the Settings dialog (Checking Mail). 
It is used to download complete messages that exceed the specified size. To download the complete message, click 
on this icon and check mail again.



Subject Field

Use this field to change the subject of the message as it is displayed in the mailbox window. To change the subject, 
type the new subject in this field and press [Enter].



Signature Combo Box

The Signature combo box allows you to automatically attach your signature or alternate signature file to the end of 
each message you send.



Attachment Type Combo Box

The Attachment Type combo box allows you to select what format documents that you attach to outgoing messages 
are encoded in: Multipurpose Internet Mail Extensions (MIME), Bin Hex, or Uuencode. MIME is best for recipients 
with MIME; Bin Hex is most compatible with old Macintosh mailers and previous versions of Eudora; and Uuencode is
best for communicating with older PC or UNIX systems.



Quoted-Printable Encoding

If this button is on, quoted-printable encoding may be used when sending messages that contain long lines of text or 
special characters. When on, it is used for all attachments. It is recommended that this button always be on.



Word Wrap

If this button is on, a carriage return is not required at the end of each line you type in an outgoing message; Eudora 
automatically wraps text to the next line, with line breaks at roughly 76 characters per line.



Tabs in Body

If this button is on, hitting the [tab] key within the message body results in Eudora inserting enough spaces to move 
the insertion point to the next tab stop. This mimics the way tabs work on many terminals. If this button is not on, 
hitting the [tab] key returns the cursor to the To: field of the message header.



Keep Copy

If this button is on, a copy of each sent message is kept in the Out mailbox (their summaries are marked with an S in 
the far left column of the Out mailbox window, indicating that they have been sent). These messages are saved until 
they are deleted or transferred to a different folder.



Text as Document

If this button is on, plain text files attached to messages are incorporated into the message as part of the message 
body.



Return Receipt

If this button is on, a cooperating mailer returns a message to you notifying you when your outgoing message is 
delivered to the addressee. The return receipt is placed in your In mailbox. This function does not work in all cases.



Open Next Message

Opens the next message in the mailbox.



Open Previous Message

Opens the previous message in the mailbox.



New Text File

Opens a text window so you can create a text file from within Eudora.



Open Text File

Displays the standard File dialog so you can find and open a file.



Open Attachment

Opens an attachment in a composition window or a received message, as long as the attachment is highlighted (in a 
composition window) or the cursor is on the same line as the attachment (in a received message).



Close

Closes the current message or window.

[Shift] + Close closes all open windows.



Save

Saves changes to the topmost window. This applies to message composition windows, signature windows, the 
Nicknames window, and the Filters window.

[Shift] + Save saves the changes to all open windows.



Save As

Displays the standard Save As dialog so that you can save the current message to a plain text file. 

If you select several messages they are all saved as one file.



Send Queued Messages

Sends all queued messages to the mail server. 

Queued messages are listed in the Out mailbox with a Q in the status column.



Check Mail

Checks your POP server for new messages and transfers them to your PC. 

If a time appears in parentheses next to this command, it is the next time an automatic mail check will occur.



Print

Prints messages, a text file, a signature file, the Filter Report window, the dialup Navigation Trace window, or the Ph 
window.



Print Preview

Displays the Print Preview window for messages, a text file, a signature file, the Filter Report window, the dialup 
Navigation Trace window, or the Ph window.



Print Setup

Displays the standard Windows Print Setup dialog. 



Exit

Exits Eudora. If edited messages or windows are still open, you will be asked to save or discard your changes.

[Shift] + Exit instructs Eudora that all open windows are to automatically reopen at the next startup.



Undo

Reverses the last editing action done on a piece of text.



Cut

Cuts the selected text and copies it to the clipboard.



Copy

Copies the selected text to the clipboard. 

[Shift] + Copy removes the carriage returns from wrapped text prior to copying it to the clipboard.



Paste

Pastes the contents of the clipboard at the insertion point in a message or message header.



Paste As Quotation

Pastes the contents of the clipboard at the insertion point in a message with a > character at the beginning of each 
line to denote quoted text.



Clear

Deletes selected text without copying it to the clipboard



Select All

Selects the entire contents of a message or mailbox.



Wrap Selection

Inserts carriage returns at the end of each line of the current selection, in the same way Eudora does when it sends 
mail. 

[Shift] + Wrap Selection unwraps the current selection (removes the carriage returns).



Finish Nickname

Completes the partial text of a nickname in a message header field. 

[Shift] + Finish Nickname inserts the full nickname expansion in the message header field.



Insert Recipient

Inserts the chosen recipient at the insertion point.



Find... Find

Displays the Find dialog so that you can find a character string within one message, multiple messages, or even 
multiple mailboxes.



Find Again Command

Continues a search within the same message.



Enter Selection Command

Inserts a highlighted character string in Eudora into the Character String field of the Find dialog.



Sort by Status

Sorts the message summaries within a mailbox by status.

You can also sort a mailbox based on the information contained in any column simply by clicking on the column 
heading. [Shift] + Sort command sorts in descending order.



Sort by Priority

Sorts the message summaries within a mailbox by priority.

You can also sort a mailbox based on the information contained in any column simply by clicking on the column 
heading. [Shift] + Sort command sorts in descending order.



Sortby Attachment

Sorts the message summaries within a mailbox by attachment.

You can also sort a mailbox based on the information contained in any column simply by clicking on the column 
heading. [Shift] + Sort command sorts in descending order.



Sort by Label

Sorts the message summaries within a mailbox by label.

You can also sort a mailbox based on the information contained in any column simply by clicking on the column 
heading. [Shift] + Sort command sorts in descending order.



Sort by Sender

Sorts the message summaries within a mailbox by sender.

You can also sort a mailbox based on the information contained in any column simply by clicking on the column 
heading. [Shift] + Sort command sorts in descending order.



Sort by Date

Sorts the message summaries within a mailbox by date.

You can also sort a mailbox based on the information contained in any column simply by clicking on the column 
heading. [Shift] + Sort command sorts in descending order.



Sort by Size

Sorts the message summaries within a mailbox by size.

You can also sort a mailbox based on the information contained in any column simply by clicking on the column 
heading. [Shift] + Sort command sorts in descending order.



Sort by Subject

Sorts the message summaries within a mailbox by subject.

You can also sort a mailbox based on the information contained in any column simply by clicking on the column 
heading. [Shift] + Sort command sorts in descending order.



Check Spelling

Checks current message composition windows, text files, and signature files for spelling errors. If a misspelled, 
unknown, or repeated word is found, the Check Spelling dialog is displayed with the word listed in the Unknown field.



In

Opens the In mailbox. 

All incoming messages are stored in this mailbox until they are filtered, transferred, or deleted.



Out

Opens the Out mailbox. 

All messages you compose, save, and queue are stored in this mailbox until they are sent. Also, if the Keep copies 
of outgoing mail option in the Options dialog (Sending Mail) is turned on, a copy of each outgoing message is    
saved in this mailbox.



Trash

Opens the Trash mailbox. 

All deleted messages are stored in this mailbox until you select Empty Trash from the Special menu. If the Empty 
Trash when exiting option in the Options dialog (Miscellaneous) is turned on, the Trash is automatically emptied 
when you exit Eudora. Deleting a message from this mailbox permanently deletes the message.



Your Mailbox

Opens a mailbox you have created. 



New...

Displays the New Mailbox dialog so that you can create a new mailbox or mailbox folder.



New Message

Opens a new message composition window.



Reply

Generates a reply message to a current incoming message. 

The original senders name is automatically placed in the To: field of the message header, and the senders text is 
included at the beginning of the message body (with a > at the beginning of each line).



Forward

Generates a forward message from a current incoming message. 

The header and body of the original message are placed at the beginning of the message body (with a > at the 
beginning of each line).



Redirect

Generates a redirect message from a current incoming message. 

The address in the From: field of the message header is that of the original sender by way of your address.



Send Again

Reformats a message that was returned to you by the mail server so that you can send it again without including all 
of the return information.

A    message is typically rejected because of an error in the recipients address, although there are many other 
possible reasons.



New Message To

These commands are used with the Quick Recipient list. Selecting an address or nickname from the list next to one 
of these commands generates a new, reply, forward, or redirect message to that recipient. All four commands share 
the same Quick Recipient list.



Reply To

These commands are used with the Quick Recipient list. Selecting an address or nickname from the list next to one 
of these commands generates a new, reply, forward, or redirect message to that recipient. All four commands share 
the same Quick Recipient list.



Forward To

These commands are used with the Quick Recipient list. Selecting an address or nickname from the list next to one 
of these commands generates a new, reply, forward, or redirect message to that recipient. All four commands share 
the same Quick Recipient list.



Redirect To

These commands are used with the Quick Recipient list. Selecting an address or nickname from the list next to one 
of these commands generates a new, reply, forward, or redirect message to that recipient. All four commands share 
the same Quick Recipient list.



Send Immediately

Sends the current message to the mail server.

You can change this command in the Options dialog (Sending Mail) to Queue For Delivery so that your outgoing 
messages are put in a queue until you send them all at the same time.



Queue For Delivery

Saves the current message in the Out mailbox and marks it as Q (queued      for delivery). Send your Queued 
messages by selecting Send Queued Messages from the File menu.

You can change this command in the Options dialog (Sending Mail) to Send Immediately.



Attach File

Displays a standard File dialog so that you can attach a file to the current message. Any file can be attached to and 
sent with a Eudora message.



Change... Queuing

Displays the Change Queuing dialog so that you can modify the queueing status of an outgoing message. 

Use this dialog to queue the current messages, unqueue messages, or set a time for queued messages to be sent.



Change... Status... Unread

Changes the status of the current messages to unread.



Change... Status... Read

Changes the status of the current messages to read.



Change... Status... Replied

Changes the status of the current messages to replied.



Change... Status... Forwarded

Changes the status of the current messages to forwarded.



Change... Status... Redirected

Changes the status of the current messages to redirected.



Change... Priority... Highest

Changes the priority of the current messages to highest.



Change... Priority... High

Changes the priority of the current messages to high.



Change... Priority... Normal

Changes the priority of the current messages to normal.



Change... Priority... Low

Changes the priority of the current messages to low.



Change... Priority... Lowest

Changes the priority of the current messages to lowest.



Change Label

Changes the label of the current messages to the selected label that you have created.



Delete

Transfers the current message(s) to the Trash mailbox.



In

Transfers the current message(s) to the In mailbox.



Out

Transfers the current message(s) to the Out mailbox.



Trash

Transfers the current message(s) to the Trash mailbox.



Your Mailbox

Transfers the current message(s) to the a mailbox you have created.



New...

Displays the New Mailbox dialog so that you can create a new mailbox and transfer the current message(s) into it.



Filter Messages

Runs all manual filters on the current messages. 

This is the only way that filters designated as Manual in the Filters window can be used.



Make Nickname...

Creates a single nickname from multiple selected nicknames.

To do this, highlight multiple nicknames in the Nicknames window, highlight one or more addresses in a message 
window, or select one or more message summaries, then select Make Nickname.



Add as Recipient

Adds the highlighted e-mail address(es) to the Quick Recipient list. 

To do this, highlight one or more addresses in a message window, then select Add as Recipient.



Remove Recipient

Removes the selected recipient from the Quick Recipient list.



Empty Trash

Permanently deletes messages from the Trash mailbox. 

If the Empty Trash when exiting option in the Options dialog (Miscellaneous) is turned on, the trash is emptied 
automatically when you exit Eudora.



Compact Mailboxes

Recovers the unused (wasted) space from all of your mailboxes. 

This wasted space was created when messages were deleted or transferred from the mailboxes.



Forget Password

Makes Eudora forget that you have already entered your password for this session. 

You will be prompted to reenter your password at the next mail check.



Change Password...

Displays the Password change dialog so that you can change your Eudora password.

This will only work if you have the necessary software on your server.



Filters

Displays the Filters dialog so that you can create filters that automatically sort your incoming and outgoing mail.



Mailboxes

Displays the Mailboxes window so that you can create, rename, remove, and move mailboxes and folders.



Nicknames

Displays the Nicknames window so that you can create, edit, or remove nicknames.

A nickname (sometimes called an alias) is an easily remembered, shorter substitute for an e-mail address or group of
addresses. Nicknames can be used in place of proper e-mail addresses in the To:, Cc:, and Bcc: fields in the headers
of outgoing messages.



Ph

Displays the Ph window so that you can access Ph and finger directory services.



Signature

Displays the Signature window so that you can create a primary signature to be included at the end of your outgoing 
messages.



Alternate Signature

Displays the Alternate Signature window so that you can create an alternate signature to be included at the end of 
your outgoing messages.



Options...

Displays the Options dialog so that you can set Eudora options.



Cascade

Arranges all open windows in a cascade. 



Tile Horizontal

Arranges all open windows as horizontal tiles. 



Tile Vertical

Arranges all open windows as vertical tiles. 



Arrange Icons

Arranges iconified windows along the bottom of the Eudora window. 



Send To Back

Sends the active window to the back. 





Find Dialog

Use this dialog to find a character string within one message, multiple message, or even multiple mailboxes. 



Find Button

Initiates a new search in a current message.



Next Command

Continues a search until the character string is found in either the same message or one of the other messages in the
current mailbox.



Next Message Command

Begins a search at the next message following the current message. 

Eudora continues the search even if it has to open more than one message or a new mailbox.



Next Mailbox Command

Begins the search at the next mailbox following the current mailbox. 

Eudora continues the search among all messages in that mailbox and any subsequent mailboxes, including the In, 
Out, and Trash mailboxes.



Character String Field

Specifies the character string to be found. 

You can type the string into this fieldor highlight the character string you want (somewhere in Eudora), then select 
Enter Selection from the Find submenu. This automatically inserts the highlighted string into this field.



Match Case

When this is checked, Eudora searches for exact matches of the character string, including any capitalization.



Summaries Only

When this is checked, Eudora searches only only the Sender and Subject fields of message summaries as they 
appear in mailbox windows. (This is much faster than a full search).



Checking Spelling

Use this dialog to check for misspellings in the body of current message composition windows, text files, and 
signature files. It includes a built-in dictionary and also allows for the creation of a custom user dictionary. 

You can set the spell checker to ignore capitalized words, words with numbers, and mixed case words, to report 
mixed case and doubled (repeated) words, and to suggest alternative spellings. 



Unknown Field

The unknown word is one that is not found in Eudora's    dictionary or your own custom dictionary. You can act on an 
unknown word using the buttons in this dialog. 



Change To Field

Gives a suggestion for the correction, and lets you enter your own text if the suggestion does not work. You can also 
click on a suggestion in the Suggestions field and it will be entered in the Change To field.

To change the unknown word to the text in the Change To field, click on the Change or Change all button.



Suggestions Field

Lists suggestions for the correct spelling of the unknown word. 

If the Always Suggest option is turned on (click on Options to see what options are on), all suggestions are listed 
here by default. If the option is turned off, click the Suggest button to display the suggestions.



Ignore Button

Leaves this occurrence of the unknown word as it is and continues the spelling check.



Ignore all Button

Leaves all occurrances of the unknown word as they are and    continues the spelling check.



Change Button

Changes the unknown word to the text in the Change To field.



Change all Button

Changes every occurrence of the unknown word to the text in the Change To field.



Suggest Button

Displays in the Suggestions field all the suggestions for the correct spelling of the unknown word. If there are no 
suggestions in the dictionary, then none are listed.

If you want the suggestions displayed automatically, click on the Options button and turn on the Always Suggest 
option.



Add Button

Adds the unknown word to your custom dictionary.



Edit Dictionary Button

Displays the User Dictionary dialog so that you can add or delete words or clear your dictionary. 



Edit Dictionary Dialog

Use the User Dictionary dialog to add words to or delete words from your dictionary, or to clear the entire dictionary.



Word:

Specifies what word is to be added or deleted from your dictionary.

You can type this into the field, or select a word from the dictionary.



Dictionary

Lists the words in your dictionary.



Add

Adds the word in the Word: field to your dictionary.



Delete

Deletes the word in the Word: field from your dictionary.



Clear

Clears the dictionary so that it is left empty.



Options Button

Displays the spell checking Preferences dialog so that you can set your spell checking options.



Check Spelling Preferences

Lists the six spell checking options. A check mark in the box next to the option name indicates that it is turned on.



Ignore capitalized words

If this is checked, words that start with capital letters are ignored.



Ignore words with numbers

If this is checked, words that contain numbers are ignored.



Ignore words with mixed case

If this is checked, words that contain both upper and lower case characters are ignored.



Report words with mixed case

If this is checked, words that contain both upper and lower case characters are reported and identified as Mixed case.



Report doubled words

If this is checked, words that appear twice in sequence in text are reported and identified as Doubled words.



Always suggest

If this is checked, Eudora's suggestions for the correct spelling of an unknown word are displayed    in the 
Suggestions field by default. 



New Mailbox Dialog

Use this dialog to create a new mailbox.



Name the new mailbox Field

Enter the name of the new mailbox.



Make it a folder

If this is checked, the new mailbox is created as a folder.

The New Mailbox dialog is displayed again so that you can create a mailbox that goes into the folder.



Dont Transfer

If this is checked, the new mailbox is created but the selected messages are not transferred into it.



Change Queuing...

Use this dialog to queue the current messages, unqueue messages, or set a time for queued messages to be sent.



Send Message:

These options specify when the selected messages should be sent.



Right Now

Sets the message to send immediately when you click the OK button.



Next Time Queued Messages are Sent

Sets the message to be sent the next time queued messages are sent.



On or after

Sets a time and date for the message to be sent. 

The message is saved in the Out mailbox with a Q in the status column, just as if it were a normal queued message. 
However, the message is not sent until the specified time.

For the message to be sent at the correct time, Eudora must be running at that time. If Eudora is not running then, the
message is sent when Eudora is opened.



Time

Specifies what time the message will be sent. 

Change the default time if you want the message to be sent at a different time. The message is saved in the Out 
mailbox with a Q in the status column, then sent at the specified time.



Date

Specifies what date the message will be sent. 

Change the default date if you want the message to be sent at a different date.The message is saved in the Out 
mailbox with a Q in the status column, just as if it were a normal queued message, then sent on the specified date.



Don't Send

Changes the message status from queued to saved.



Filters

Displays the Filters window so that you can create filters that automatically sort your incoming and outgoing mail.



Filters Dialog

Use this dialog    to create filters that automatically sort your incoming and outgoing mail. 

To start, click the New button. Then specify the criteria and the action. When you close the filters window, you will be 
promted to save your changes. 



Filter List

Displays the filters you have defined.

Filters are invoked from top to bottom as shown in the list. This order may be important when overlapping matches 
exist. 



Up Button

Moves the selected filter up in the filter list, changing the order it is invoked.



Down Button

Moves the selected filter down in the filter list, changing the order it is invoked.



New Button

Adds a new filter named Untitled is to the filter list. Eudora names this filter based on the information you enter in the 
Header and Matching Text fields.



Remove Button

Removes the selected filter from the filter list. The filter is deleted when you save changes to the Filters window.



Incoming

If this is checked, the filter is invoked on all incoming messages.



Outgoing

If this is checked, the filter is invoked on all outgoing messages after they are sent.



Manual

If this is checked, the filter is invoked only when you select Filter Messages from the Special menu.



Header Field

Specifies which section of the message the filter will search. You can use one of the items in the list, or type in a 
header field (for example, X-Priority:).

The Any Header selection searches all message headers, and the Body selection searches the message body.



Match Type Field

Specifies the type of match the filter performs when comparing the character string to the specified header. 

To filter a message based only on the header types it contains (not the text of the header), use appears or doesnt 
appear.



Matching Text Field

Specifies the character string that the filter searches for.

Keep this as specific and brief as possible. The greater the complexity of the search string, the less the likelihood of 
an exact match.



Conjunction Combo Box

Specifies how the second criteria is to be used.



Make Subject

Applies the specified subject to the filtered messages. 

The new subject is given in the message summary in the mailbox window, but the subject is not changed in the 
message itself.

To include the text of the previous subject in your new subject, use the & symbol. For example, typing test 
message:& in this field results in test message: previous subject.



Label

Applies the selected label to the filtered messages. 



Raise Priority

If this is checked, the filtered messages priority is raised one level.



Lower Priority

If this is checked, the filtered messages priority is lowered one level.



Transfer To Mailbox

Transfers the filtered messages to the selected mailbox. 

To set this option, click on the Transfer To button (the default is blank) and select a mailbox from the Transfer menu. 
(A popup menu is displayed asking you to do this.)

To send a copy of the filtered message to a mailbox    and leave the original in your In mailbox, hold down the [Shift] 
key while selecting the Transfer To option.



Mailboxes

Use the Mailboxes window to create, rename, remove, and move mailboxes and folders.



Current Mailbox/Folder

Gives the name of the mailbox or folder whose contents are displayed in the list below.



Mailbox List

Lists all of the mailboxes and folders contained in the current folder.



Rename Button

Renames the mailbox or folder that is highlighted in the list.

A dialog is displayed prompting you for the new name.



Remove Button

Removes the mailbox or folder that is highlighted in the list.

If there are messages in the mailbox, you will be prompted for whether or not you want to remove everything.



New Button

Creates a new mailbox or folder within the current folder. 



>>Move Button>>

Moves the highlighted mailbox or folder in the lefthand list to the righthand list.



<<Move Button<<

Moves the highlighted mailbox or folder in the righthand list to the lefthand list.



Nicknames

Use the Nicknames window to create, edit, or remove nicknames.

A nickname (sometimes called an alias) is an easily remembered, shorter substitute for an e-mail address or group of
addresses. Nicknames can be used in place of proper e-mail addresses in the To:, Cc:, and Bcc: fields in the headers
of outgoing messages.



Nicknames File

Gives the name of the nicknames file that the selected nickname is in. The Main Nicknames file is the standard 
Eudora nicknames file.

If you have multiple nicknames files, put them in a new directory within the Eudora directory called Nickname. Leave 
the standard Eudora Nicknames file (nndbase.txt) in your Eudora directory. Do not place it in the newly-created 
Nickname directory.

When the Nicknames window is displayed, all nicknames in all files within this directory are listed along with your 
standard nicknames.

If you create a new nickname, the new nickname dialog lets you select the file you want the nickname placed into.



Nickname Field

Lists all your nicknames. Single-click on the nickname to display all of its current information.

To add a nickname to or remove a nickname from the Quick Recipient, move the mouse pointer over the space just to
the left of the nickname in the Nickname field. The pointer changes to a selection tool. Single-click to add or remove a
nickname to/from the Quick Recipient list. A bullet next to the nickname indicates that it is on the list.



Address(es) Field

Displays a selected nicknames expansion (the address or addresses that the nickname represents). 

To create a nickname for a group of people, add the nicknames or addresses and separate them with commas or 
carriage returns (øEnter). This is the only place you can use a carriage return to separate addresses. 

You can add someone's proper name to their address by putting it in parentheses after the e-mail address. The 
proper name is put in the To: field of mail messages along with the full address.



Notes Field

Gives your private notes on a nickname.



New Button

Creates a new nickname.

The New Nickname dialog is displayed prompting you to name the nickname and whether or not you want
to put it on the Quick Recipient List.



Remove Button

Removes a selected nickname from the nickname list.



Rename Button

Renames a selected nickname. 

The Rename Nickname dialog is displayed prompting you to rename the nickname and whether or not you want to 
put it on the Quick Recipient List.



To Button

Creates a new message addressed to the selected nickname

You can select multiple nicknames by holding down the [Ctrl] key and clicking on each nickname.



Cc Button

Adds the selected nickname(s) to the Cc: field of the topmost message composition window.



Bcc Button

Adds the selected nickname(s) to the Bcc: field of the topmost message composition window.



Ph

Use the Ph window to access two different directory services, Ph and Finger.

Ph and Finger inquiries will only work if you have the appropriate software running on your server.



Server Field

Lists the Ph server from the Ph Server field of the Options dialog [Hosts]). 

You can enter a differnet server name for this session. The next time you open the window, the server will be reset to 
the name in the Options dialog.



Command Field

Specifies the name or address being searched for, whether you will use Ph or Finger.



Response Field

Displays the server or host response.



Ph Button

Initiates a Ph query for the the text in the Command field.



Finger Button

Initiates a Finger query for the text in the Command field.



Signature

Use the Signature window to create your primary signature. 

When enabled in the Options dialog (Sending Mail) or on the message icon bar, this signature is automatically added 
to the end of outgoing messages. Eudora also supports an alternate signature.



Alternate Signature

Use the Alternate Signature window to create your alternate signature. 

When enabled (on the message icon bar), this signature is automatically added to the end of outgoing messages. 
Eudora also supports a primary signature.





POP account:

Specifies the name of your account on your POP server.

Enter your login name, an "@" sign, and the (domain) name of the computer. For example, srondo@qualcomm.com. 
(When you enter your account name here, it is made available in the POP account field of other Options categories.)

A POP account is an account on a    computer that runs a Post Office Protocol version 3 (POP3 or POP) server. This 
is the account to which your e-mail messages are delivered so that Eudora can find them and transfer them to your 
PC. You must have a POP account to be able to receive mail with Eudora.



Real name:

Specifies your real name. 
Enter your name as you want it to appear in the From field of your outgoing mail messages. Your return address is 
also given in that field.



Connection Method:

These options specify the connection method, or Offline for no connection.



Winsock

Specifies a Winsock connection.

Select this option if you are using Eudora via TCP/IP software (a direct network connection, SLIP, or PPP).



Dialup

Specifies a dialup connection.

Select this option if you are using Eudora directly through a modem without the benefit of TCP/IP software, select 
Dialup.



Offline (no connection)

Specifies no connection.

Select this option if you don't want Eudora to attempt to make any connections.



POP account:

Specifies the name of your account on your POP server.



Real name:

Specifies your real name. 



Return address:

Specifies a return address other than your POP account. 

Enter a different address if you do not want return mail to go to your POP account. 

If you enter an address in this field, first test the address to be sure that mail sent to it is indeed delivered to you. If 
you use an invalid return address, no one can reply to your mail.



Dialup username:

Specifies your dialup user name.

Enter your dialup user name if it is different from your POP account. This is necessary if you are using Eudora directly
through a modem without the benefit of TCP/IP software, and you have a secondary user name for use during the 
dialup process (this might be used as your login name to a terminal server, for example). See Appendix E of your 
user manual for details regarding how this field can be used.



SMTP:

Specifies the name of the SMTP (Simple Mail Transfer Protocol) server computer. 

Enter the name of your SMTP server if it is different from the machine that is running your POP server. You do not 
need a login name on this computer, but you must have access to it through your network.



Ph:

Specifies the name of the machine running your Ph server.

Enter the machine name, or leave the field blank.



Finger:

Specifies the name of the machine running your finger server.

Enter the machine name, or leave the field blank. If you leave it blank, Eudora uses your SMTP server as your finger 
server.



POP account:

Specifies the name of your account on your POP server.



Check for mail every ? minutes

Specifies how often Eudora checks the POP server for new mail. 

Enter 0 to disable automatic checking, or any number of minutes. 

It's a good idea to set this at no less than 15 minutes. Checking mail more frequently puts an unnecessary drain on 
your POP server. This option only works when Eudora is running.



Skip messages over ? K

If this is checked, messages over the specified size are downloaded with only the first few lines of the message body.
This can be useful on slow connections.

To download the entire message, click on the Fetch icon in the message and select Check Mail from the Find menu.



Send on check

If this is checked, any messages that are queued in the Out mailbox are sent when Eudora checks the POP Server 
for new mail. 



Save password

If this is checked, your password is stored in Eudora and you never have to enter it again, even if you exit Eudora and
restart. 

Only use this option if your PC is in a secure place.



Leave mail on server

If this is checked, incoming messages are transferred to your PC and also left on the server. (Normally your mail is 
transferred, then deleted from the POP server.) 

This option works in conjunction with the Delete from server after ? days, Determine first unread message by, 
and Delete from server when emptied from Trash options.



Delete from server after ? days

If this is checked, any mail left on the server (using the Leave mail on server option) will be deleted after the 
specified number of days. 

It is a good idea not to leave copies of your messages on the server indefinitely, as this will create mail storage 
problems on the server.



Determine first unread message by:

These options specify what determines an unread message.



First message not read by this machine

Specifies that any message not previously read by this machine is considered unread.



Status: headers

Specifies that any message not identified as read in the message Status: header is considered unread.



POP3 LAST command

Specifies that any message after the LAST downloaded message is considered unread. 

This method is more efficient than the Status: headers method when connecting to a POP server that supports the 
LAST command.



Delete from server when emptied from Trash

If this is checked, all messages that you have deleted from your trash mailbox are also deleted from the server.

This only applies to messages that were transferred to your PC under the Leave mail on server option. Normally 
Eudora deletes a message from the server immediately after the message is transferred.



Authentication Style

These options specify the authentication style. Ask your e-mail administrator which one is being used at your site.



Authentication Style

Specifies the authentication style. Ask your e-mail administrator which one is being used at your site.



Return address:

Specifies a return address other than your POP account. 



 Domain to add to unqualified names:

Specifies a domain to be added to unqualified names.

An unqualified name is one that doesn't have an "@" sign followed by a domain name. If you address a message to 
someone without including their domain name, Eudora automatically adds this domain to that address. This setting 
can be used as a time-saving device when addressing large numbers of messages to users who reside in the same 
domain. 



SMTP server:

Specifies the name of the SMTP (Simple Mail Transfer Protocol) server computer. 

Enter the name of your SMTP server if it is differnet from the machine that is running your POP server. You do not 
need a login name on this computer, but you must have access to it through your network.



Immediate send

If this is checked, all send options are set to Send Immediately. 

If this is not checked, messages are saved in the Out mailbox and marked Q (queued for delivery).

Send options include the rightmost button in the icon bar of the message composition window and the Send 
Immediately option in the Message menu.



Send on check

If this is checked, all the messages marked Q in the Out mailbox are sent when Eudora checks the POP server for 
new mail. 



Word wrap

If this is checked, carriage returns are automatically inserted to make    lines that are a maximum of 76 characters. 

The carriage returns are added in the send process, so until you send the message the lines will display the full width 
of your message window.



Fix curly quotes 

If this is checked, all "smart" quotation marks in message text or attachments are replaced with "conventional" 
quotation marks. 

If your recipients have MIME, there's no reason to use this option. Only turn it on if most of the people you 
correspond with don't use MIME.

The "smart" quotation marks are special characters, and this option allows messages to be sent without using 
quoted-printable encoding. 



May use Quoted-Printable

If this is checked, Eudora uses quoted-printable encoding when necessary, such as when messages that contain long
lines of text or special characters are sent. 

If this is not checked, quoted-printable encoding is never used.



Keep copies of outgoing mail 

If this is checked, a copy of each message you send is saved    in the Out mailbox and marked    S. 

If this is not checked, Eudora moves outgoing messages to the Trash mailbox after they are sent.



Use signature

If this is checked, your Signature is automatically attached to the end of outgoing messages.

You can turn this off for specific messages by selecting None in the Signuature combo box of the outgoing message 
window.



Tabs in body of message

If this is checked, when you enter the [tab] key within the message body, spaces are inserted to create a tab space.

 If this is not checked, the [tab] key moves you through the fields of the message window.



Encoding Method:

These options specify what encoding method should be used with attached files.



MIME

If this is checked, documents attached to outgoing messages are encoded in MIME. 

MIME is best for recipients with MIME.



BinHex

If this is checked, documents attached to outgoing messages are encoded in BinHex. 

BinHex is best for recipients with old Macintosh mailers and previous versions of Eudora.



Uuencode

If this is checked, documents attached to outgoing messages are encoded in Uuencode Data Fork. 

Uuencode is best for communicating with older PC or UNIX systems.



Put text attachments in body of message

If this is checked, plain text documents that are attached to an outoing message are sent in the message body. They 
are not sent as attachments.



Attachment Directory:

Specifies what directory your incoming attachments will be put in.

To change the directory, single-click on the directory name button (the default is blank). A dialog is displayed allowing 
you to select the attachment destination directory. 

If you do not select an attachment directory, attachments are placed in your Eudora directory.



Delete attachments when emptying Trash

If this is checked, attachments are deleted when their corresponding messages are deleted from the Trash (or the 
Trash is emptied).

The attachment must be in the directory defined as the Attachments Directory. 

If you want to save an attachment but delete the message, move the attachment to another directory or leave this 
option off.



Screen Font:

Specifies the font and point size to be used for displaying the text of your Eudora messages and mailbox windows. 

To change the selection, click on this button. The Font dialog is displayed so that you can select a new font and size.



Print Font:

Specifies the font and point size to be used when printing messages using the Print... command.

To change the selection, click on this button. The Font dialog is displayed so that you can select a new font and size.



Message window width:

Specifies the width of new and received message windows (in characters). The default    is 80.

This setting has no effect on what your mail looks like when it is sent. When mail is sent, Eudora wraps at or before 
76 characters.

If you use a proportional font, Eudora sets the window width based on the average width of the characters in the font.



Message window height:

Specifies the height of new and received message windows (in lines). The default value is 20.

If the Zoom windows when opening option is turned on, received message window heights are automatically 
adjusted to the height of the message text.



Zoom windows when opening

If this is checked, new windows automatically sized to display their contents without empty space. 

The zoomed size is computed on a window-by-window basis. For message windows, zoomed size is just long 
enough to display all of the message (but no longer than the main window), and as wide as the Message Window 
Width setting. Composition windows zoom to the height specified by the Message Window Height setting.



Show all headers (even the ugly ones)

If this is checked, the complete message header of incoming messages is displayed, including the routing 
information.

If dont want to leave this option on but want to see all headers for an specific incoming message, click on the BLAH, 
BLAH, BLAH icon in the message icon bar.



Show toolbar

If this is checked, the main window toolbar is displayed.



Show toolbar tips

If this is checked, holding the mouse pointer over a button in the main window toolbar displays a very brief description
of that button's function.



Show status bar

If this is checked, a status bar is displayed at the bottom of the main window. The status bar provides a brief 
description of menu items and toolbar buttons.



Show category icons

If this is checked, the Options categories are presented with    icons and the name. 

If this is not checked, the categoris are presented with just the name.



Labels
The Labels options define the title and color of the seven labels that can be used to categorize messages. To change 
a label title, type the new title in the field to the right of the label number. To change a label color, single-click on the 
label number to display the Color dialog. 

In the Color Dialog, you can select from one of the pre-defined Basic Colors or create your own Custom Colors. To 
assign a basic color to a label, select the color and click OK. To create a custom color, click the Define Custom Colors
button to display the custom colors palette. 

To define a custom color, select one of the 16 custom color boxes. Using the mouse pointer, click anywhere on the 
color palette to select the color Hue and Saturation. Use the color control bar to the right of the color palette to adjust 
the color. When you are satisfied with the color, click the Add to Custom Colors button. Once you have completed 
creating the custom colors, select the desired label color and click OK.



Use an alert dialog box

If this is checked, an alert dialog notifies you when you have new mail.



Open mailbox

If this is checked, mailboxes are opened when new mail is received, and the first unread message is highlighted. 



Play a sound

If this is checked, Eudora plays the sound when new mail    arrives. 

To select a sound (.wav) file, click on the Play a sound button. The Select Sound File dialog dialog is displayed so 
that you can select a sound.



Select Sound File

Specifies the sound file to be played when new mail arrives. 

To select a sound (.wav) file, click on this button. The Select Sound File dialog dialog is displayed so that you can 
select a sound.



Reply to all (otherwise when Shift is down)

If this is checked, when you do a Reply the message includes every recipient of the original message, not just the 
sender. 

If this is not checked, the reply is only addressed to the original sender. If this option is off you can hold down the 
[Shift] key while selecting Reply to generate a reply to all    recipients.



When Replying to all:

These options specify how a reply message will be generated.



Include yourself

If this (and Reply to all) is checked, when you do a Reply the reply includes your address so that you receive a copy 
of your own reply. 

If this is not checked, the reply does not include your address and you do not receive a copy. (Unless you have 
checked Keep copies of outgoing mail    in the Sending Mail    category.)



Put original To: recipients in Cc: field

If this (and Reply to all) is checked, when you do a Reply the reply includes the addresses of the original message 
recipients in the Cc: field. The To: field contains only the address of the original sender.



Copy original's priority to reply

If this is checked, when you do a Reply the reply has the same priority as the original message.



Dialup username:

Specifies your dialup user name.

Enter your dialup user name if it is different from your POP account. This is necessary if you are using Eudora directly
through a modem without the benefit of TCP/IP software, and you have a secondary user name for use during the 
dialup process (this might be used as your login name to a terminal server, for example). See Appendix E of your 
user manual for details regarding how this field can be used.



Phone number:

Specifies the telephone number for your terminal server.

Enter the number, and be sure to include any necessary prefixes to get an outside line, turn off call-waiting, etc.



Modem:

Specifies your modem type. 

Select your modem from the popup or, if your modem is not listed among those available, select *Default:Hayes 
(unreliable transfers). 

While the default modem functions in many cases, you may experience data corruption when sending or receiving 
messages. To configure Eudora for a reliable connection using the default modem, you must modify the 
SERIAL.MOD dialup file, as described in Appendix E of the user manual.



Baud rate:

Specifies your baud rate.

Select the value that corresponds with your modem speed.



COM port:

Specifies the COM port that your modem is connected to on your PC. 

Select the appropriate port.



Flow Control:

Specifies the modem flow control. 

Flow control is the ability of the modem and PC to stop the data flow before the internal buffers fill up and overflow. 
The modem may use either hardware or software flow control (software flow control is typically the modem default 
setting), but hardware is preferred and strongly recommended at baud rates above 9600. If your modem does not 
support hardware flow control, then you must use software flow control. Software flow control, however, does not 
work well at speeds above 9600 baud.



Data bits:

Specifies a terminal server setting. The default value is correct for almost all cases. Consult with your local Eudora 
support coordinator or service provider before you change this value.



Stop bits:

Specifies a terminal server setting. The default value is correct for almost all cases. Consult with your local Eudora 
support coordinator or service provider before you change this value.



Parity:

Specifies a terminal server setting. The default value is correct for almost all cases. Consult with your local Eudora 
support coordinator or service provider before you change this value.



Service provider:

Specifies the service provider whose terminal server Eudora is connecting to. 

If your service provider is listed among those available, select it. If not, select *Default (must modify).

The default service provider will not function until the SERIAL.NAV dialup file is modified to work with your service 
provider, as described in Appendix E of the user manual.



Dialup timeout after ? seconds

Specifies the number of seconds before a dialup connection will time out. The default is 60.

Change the number of seconds if you want more time before the connection will time out.



CRLF Processing

If this is checked, Eudoras cr/lf processing is on. 

Telnet programs routinely translate carriage returns into carriage return (cr)/ linefeed (lf) pairs. For this reason, 
Eudora processes cr/lf pairs to plain carriage returns by default. If your terminal server does not translate carriage 
returns to cr/lf pairs, or you are running srialpop to establish an echoless session (as described in Appendix E of the 
user manual), Eudora's cr/lf processing must be disabled. This can be done by turning this option off.



Show trace window

If this is checked, the Trace Window is opened automatically at the beginning of the dialup session. 

The Trace Window follows what Eudora is sending, expecting, and the characters returned to Eudora. The Trace 
Window is a valuable troubleshooting tool because when there is an error during the dialup process, the window 
displays the source of the error.



Ignore capitalized words

If this is checked, words that start with capital letters, such as proper nouns, are ignored.



Ignore words with numbers

If this is checked, words that contain numbers are ignored.



Ignore words with mixed case

If this is checked, words that contain both upper and lower case characters are ignored.



Report words with mixed case

If this is checked, words that contain both upper and lower case characters are reported and identified as Mixed case.



Report doubled words

If this is checked, words that appear twice in sequence in text are reported and identified as Doubled words.



Always suggest

If this is checked, Eudora's suggestions for the correct spelling of an unknown word are displayed    in the 
Suggestions field by default. 



Ignore Original Text

If this is checked, any text that is preceded by a > is ignored.    Eudora assumes that this text was originally from 
another message, and therefore does not need to be checked. 



Switch messages with:

These options specify what keys can be used to quickly open and close message windows.



Unmodified arrow keys

If this is checked, the keyboard arrow keys can be used to close the current message and open the next or previous 
message in the mailbox. 

The up or left arrow key opens the previous message; the down or right arrow key opens the next message. If this 
option is off, the arrow keys can be used to move the caret in messages.

Even if Unmodified arrow keys is on, the arrow keys do not switch messages if there is a message composition 
window topmost on the screen.



Ctrl+arrow keys

If this is checked, you can switch between open messages by holding down the [Ctrl] key and then pressing the arrow
keys.



Alt+arrow keys

If this is checked, you can switch between open messages by holding down the [Alt] key and then pressing the arrow 
keys.



Require confirmation for deletes

If this is checked, you are alerted when you delete messages you haven't read, or when you transfer queued 
messages out of the Out mailbox.



Close messages with mailbox

If this is checked, all open messages are closed when you close the mailbox they are in.



Empty Trash when exiting

If this is checked, the Trash mailbox is emptied every time you exit Eudora. 

If this is not checked, the Trash is only emptied when you select Empty Trash from the Special menu.

If you want to remove some messages from the Trash mailbox but don't want to empty it entirely, highlight the 
summaries you want to delete and select Delete from the Message menu. The selected messages are deleted.



Say OK to alerts after ? seconds

If this is checked and a number of seconds is specified, any notices of network problems are dismissed after the 
specified number of seconds.

If this is not checked, notices are left in place and Eudora cannot try the communication again until you dismiss the 
alert. 



Turbo redirect by default

If this is checked, a Redirect to Recipient command does the following:

Opens a redirected message to the selected recipient
Queues the new message
Deletes the original message

To turn this option on or off (regardless of this setting), hold down the [Shift] key while selecting a redirect recipient.



Automatically open next message

If this is checked, the next unread message is opened when you delete or transfer the current message.



Use asynchronous Winsock calls for

These options specify how Winsock calls are made using a TCP/IP stack. If you're experiencing trouble with your 
Winsock connection, make sure both of these options are off.



All non-database functions

Specifies asynchronous Winsock calls for all non-database functions.

There are two methods of making Winsock calls using TCP/IP stacks, blocking and asynchronous. Because of the 
ability to handle error conditions more gracefully, asynchronous is the preferred method when using Eudora. 
However, some TCP/IP stacks do not handle asynchronous calls correctly. If you're experiencing trouble with your 
Winsock connection, make sure both of these options are off.



Database functions

Specifies asynchronous Winsock calls for database functions.

There are two methods of making Winsock calls using TCP/IP stacks, blocking and asynchronous. Because of the 
ability to handle error conditions more gracefully, asynchronous is the preferred method when using Eudora. 
However, some TCP/IP stacks do not handle asynchronous calls correctly. If you're experiencing trouble with your 
Winsock connection, make sure both of these options are off.



Network timeout after ? seconds

Specifies the number of seconds before a network connection will time out.



Network buffer size of ? bytes

Specifies the size of the buffer that Eudora uses to transfer information to and from the server.

If you are having trouble transferring large messages, the size of this buffer may be decreased.



Cache network info

If this is checked, Eudora remembers the results of previous database functions when using the Winsock connection 
method. 

This speeds up database functions within a single Eudora session.



Use Eudora MAPI server:

These options specify when the Eudora MAPI server should run.



Never

If this is checked, the Eudora MAPI server is off and is never automatically opened.



Always

If this is checked, the Eudora MAPI server is on and is always opened on startup.



When Eudora is running

If this is checked, the Eudora MAPI server is on when Eudora is running.



Delete MAPI attachments:

These options specify when MAPI attachments should be deleted.



Never

If this is checked, MAPI attachements are never deleted.

MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you 
want to save them, use this option.



After sending message

If this is checked, MAPI attachements are deleted after their corresponding messages are sent.

MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you 
do not want to save them, use this option.



When message is emptied from trash

If this is checked, MAPI attachements are deleted after their corresponding messages are emptied from the trash.

MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you 
do not want to save them after their corresponding messages have been deleted, use this option.



Kerberos POP3 port:

Specifies the port that the Kerberos POP server is listening on.



Realm:

Specifies the network realm that the Kerberos server resides in.



Service name:

Specifies the type of service that you're requesting.



Service format:

Specifies the name of the ticket that Eudora requests from the Kerberos server.






